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Chapter 1:  Introduction 

This manual describes how to use the Qwave, Qmini, and Qred spectrometers with 
Waves application software. For information about how to control a spectrometer from 
custom user software, refer to the manuals included in the Software Development Kit 
(SDK). 

Product Overview 

With its focal length of 75 mm, the Qwave spectrometer offers technical specifications 
normally found in much larger spectrometers. It is controlled and operated by the 
spectroscopy software Waves, which not only includes unique sophisticated algorithms for 
data acquisition and evaluation, but also provides these features through a clear and 
straightforward interface. This makes the Qwave the ideal spectroscopic instrument for all 
scientific applications that require a resolution of 0.2 to 0.5 nm and a numerical aperture of 
up to 0.10. 

Within an amazingly small design, the Qmini delivers technical specifications that are 
unprecedented at this size. Its compact design enables tight integration in applications 
where space is limited, like hand-held analysis devices. This manual describes the 2016 
version of the Qmini (with the 30-pin auxiliary connector). For the previous version, 
download the corresponding manual from our website. 

The Qred is the world's first truly portable high-performance near-infrared (NIR) 
spectrometer. On a footprint smaller than a credit card, it includes high-throughput Czerny-
Turner optics with a cooled or uncooled InGaAs image sensor. The Qred spectrometer 
breaks the size and cost barriers that prevented widespread applications of NIR 
spectroscopy in many fields including food safety, quality control, medical diagnostics, and 
pharmaceutical analysis. The advanced thermal design provides high thermal stability and 
excellent heat transfer without a fan. The rugged design has no moving parts, ensuring 
reliable operation in rough environments. 
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Hardware Features 

 Miniature design 

 High spectral resolutions 

 High sensitivity and dynamic range 

 Exceptional thermal stability 

 Optical input via SMA fiber connector or free focused beam 

 Four I/O channels for external triggering, shutter control, and general purpose I/O 
(GPIO) 

 Controlled and powered via USB 2.0 

The new version of the electronics board enables: 

 Full processing of spectra in the device 

 Averaging and smoothing 

 Binning and buffering of spectra 

 A choice of different communication interfaces 

Software Features 

 Take and display series of spectra 

 Automatic exposure control with dark spectrum interpolation 

 Import most ASCII-based file formats 

 Export as ASCII table to almost any numerical analysis software 

 Comprehensive tools for displaying and analyzing spectra 

 Strip charts for comparing characteristic values between multiple spectra including 
peak follower in real time 

 Graph printing and export to PDF 

 Dynamic peak finder (no need to set a threshold level) 

 Transmission, reflection, absorption, and colorimetric measurements 

Applications 

 Light analysis 

 Chemical research 



Waves Spectrometer Software User Guide Spectrometer User Manual 
 

Broadcom  AFBR-Spectro-UG100 

8 

 Raman spectroscopy 

 Color measurement 

 Quality control 

 Counterfeit detection 

 Environmental analysis 

 Forensic analysis 

 System integration 

 Process control and monitoring 

System Requirements 

 Windows 10, 8, 7, Vista, or XP (32 or 64-bit) 

 .NET Framework Version 3.5 or 4.0 (already included in most versions of Windows) 

Package Contents 

The bulk spectrometer includes the device along with the calibration and test report. Qred 
also ships with an AC power adapter. 

The optional Spectrometer Accessory Kit includes the following: 

 USB data cable 

 CD-ROM with Waves spectroscopy software including device driver, software 
development kit, and a PDF copy of this manual 

 Printed user manual 

Optional Accessories 

 I/O port adapter 

 Fiber optical cable 

 Cosine correcting probe for irradiance measurements 

 SMA collimator 

Additional specialized accessories are available upon request.  
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Chapter 2:  Installation 

USB Interface 

Installing the spectrometer is a very straightforward process. Simply install the software 
and then connect the device to a USB port. For the operating system to properly 
recognize the device, install the software first before attaching the device. Double-click on 
the WavesSetup.exe file from the CD-ROM. Alternatively, download the latest software 
version from our website. The setup package installs the application software and the 
device driver. 

The software is tested with 32-bit and 64-bit versions of Windows 10, 8, 7, Vista, and XP. 
It requires the Microsoft .NET framework version 3.5 or 4.0, which is already installed on 
most PCs. If this framework is not installed, the setup package prompts to install it first. 
Find the setup file for the .NET framework on the CD or download it from the Microsoft 
website. 

Install the software on as many systems as necessary. For example, install it in the lab for 
measurements and in the office for further spectrum analysis. 

After the software is installed, connect the spectrometer to a USB port on the computer. 
The USB port must supply an electrical current of up to 200 mA, so connect the 
spectrometer directly to your system or to an externally powered USB hub. A flashing red 
LED on the device indicates that the port is not supplying enough power. 

Upon starting, the Waves software automatically searches for spectrometers and, if it 
finds one, initializes the device. It may take a few seconds before the spectrometer is 
properly recognized by the operating system. 

If Waves cannot find a spectrometer (or finds several), a dialog window displays with 
options for choosing a specific device or the simulated spectrometer setting. The 
simulated spectrometer option is used to evaluate the software without connecting to an 
actual device. Access this dialog window at any time by selecting Device Setup from the 
File menu. 
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UART Interface 

The Qmini and Qred spectrometers can also be controlled with the UART interface 
available on the front-side auxiliary connector. This interface is similar to a regular RS-232 
interface, but the voltage levels on the data lines are 0V (low) and +3.3V (high) instead of 
the RS-232-specified positive and negative voltages. To connect the device to a regular RS-
232 serial port, use the optional RS-232 converter cable. See Specifications on page 36 
for a pinout of the auxiliary connector. 

Though most users of the UART interface connect the device to custom user hardware, first 
operate the spectrometer using a PC and the Waves application software to become 
familiar with the device. 

When the Qwave is powered on, it initially listens on all interfaces. As soon as a message 
is received on an interface, this interface is selected and all other interfaces are disabled. 
For example, if communicating with the device via USB, it will not listen on the UART 
interface. To prevent any confusion, only connect the interface planned for use. 

The default data rate for the UART interface is 57,600 baud. This is actually quite slow, so 
we recommend to increase it in the Device Configuration window. The maximum data 
may be limited by the serial port of your computer. When connecting to a device via 
UART, the Waves application software tries the data rate of the device that was most 
recently connected. This may cause a data rate mismatch if, for example, it is changed 
and then connected to a different PC. This problem can easily be resolved by connecting 
the device via USB. When the device connection is then opened in Waves, the software 
reads the data rate from the device and uses it for subsequent UART communication. 

To use the spectrometer and UART interface with a PC, use the RS-232 converter cable 
and connect it to a serial port on the PC. Because a regular serial port does not provide a 
supply voltage, an external 5V DC power supply is required to power the spectrometer. 
Connect the power supply to the wires marked red (+ 5V) and blue (ground). 

Upon connecting the device to power, both LEDs are initially off. When the device receives 
a command on an interface or if it enumerates on the USB bus, the red LED turns off. If the 
green LED is off, check the power supply. 

To install the Waves application software, proceed as described in the previous chapter. 
When using Waves with the UART interface, note that there are two differences to the 
USB version: 

 Data transfer is slower. The default speed is 57,600 baud, but can be increased from 
the Device Configuration window. The maximum speed may be limited by the serial 
port on your system. 

 To open the device connection, de-select the Auto-Scan all ports option and select 
Qseries spectrometer on the correct COM port. 

To connect the Qwave via the UART interface to custom user hardware, see the 
connector pinout in Specifications on page 36. 
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SPI Interface 

The Qmini and Qred devices can also be controlled via the serial peripheral interface 
(SPI). Refer to the NioLink Protocol Manual in the Software Development Kit (SDK) for 
details. 

Sensor Cooling (Qred Only) 

Sensor Temperature and Dark Signal 

The Qred uses a specialized Indium Gallium Arsenide (InGaAs) image sensor to measure 
light in the Near-Infrared (NIR) wavelength range. These sensors have a much larger dark 
signal than regular sensors for visible light. To obtain a precise measurement, the image 
sensor should be cooled to minimize the dark signal. Therefore, most Qred spectrometers 
are equipped with a Thermo-electric cooler (TEC) to keep the image sensor at 
temperatures below 0°C. 

There are two types of sensors: 

 Regular InGaAs sensors cover wavelength ranges up to 1700 nm. If possible, keep 
these sensors cooled to temperatures below 0°C. The default operating temperature 
for a Qred with this kind of sensor is –5°C. The temperature may be decreased further 
if adequate cooling can be provided. This further reduces the dark signal. Operating 
these sensors at room temperature causes a decrease in measurement precision. 

 Extended InGaAs sensors cover wavelength ranges beyond 1700 nm and up to 
2500 nm. These sensors have a much larger dark signal and therefore must be 
cooled to lower temperatures than regular InGaAs sensors. These sensors include a 
two-stage thermo-electric cooler and should be operated at the default temperature of 
–20°C or below, depending on the available cooling. In addition, exposure time must 
be kept short to prevent the sensor from getting saturated by the dark signal. To 
measure weak signals, consider increasing the Averaging value instead. 

The Qred software uses sophisticated algorithms to automatically compensate the dark 
signal for different exposure times and temperatures. However, due to the large magnitude 
of the dark signal, it may not be corrected completely, especially for extended InGaAs 
sensors. If measurements must be as precise as possible, take a background spectrum first 
and use it for subsequent measurements (see Absorption, Reflection, and Transmission 
Measurements on page 27). 

The Qred controls the temperature automatically, but be aware that it may take a few 
seconds to reach the target temperature and there are certain requirements concerning 
heat dissipation and power supply. 
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In the Waves software, open the Temperature Control window from the Device menu. 
There are options for setting a target temperature and turning the temperature control 
on/off. Check the actual temperature in the status bar at the bottom of the main window. 
Wait until the target temperature is reached before starting measurements. The blue LED 
on the device also indicates the status of the temperature control: 

 Blue LED is off: The temperature control is turned off. 

 Blue LED is blinking: The target temperature has not yet been reached. 

 Blue LED is continuously lit: The target temperature has been reached. 

Change the operating temperature depending on your requirements and setup. When 
setting the temperature, take the following points into account: 

 The dark noise decreases significantly upon lowering the temperature. 

 The minimum temperature that can be reached depends on the power supply (see 
Power Supply on page 13) and the case temperature. The case temperature 
corresponds to the sink temperature displayed in the Temperature Control window. The 
TEC inside the Qred can achieve a maximum temperature difference of about 35K for 
regular sensors. So if the ambient temperature is 25°C, the minimum temperature is 
about –10°C. Extended InGaAs sensors feature a two-stage TEC than can achieve 
temperature differences of about 55K. 

 For short measurements, heat dissipation is not a concern. However, when taking 
spectra for more than a few minutes ensure that the case does not get too hot. An 
increase in case temperature limits the cooling that can be achieved. To increase heat 
dissipation, the first step may be to place the device on a metal plate (like an optics 
table). If further cooling is required, attach a dedicated heat sink to the bottom of the 
device with thermal grease or a thermally conductive pad. Continuous operation over 
longer time periods of the spectrometer usually requires an additional external fan. 

 If the heat generated inside the image sensor cannot be dissipated quickly enough, a 
heat build-up may occur. In this case, the accumulated heat causes the device case 
to heat up, which in turn increases the electrical power required to cool the sensor, 
which in turn causes the case to heat up even more. This condition is also known as 
thermal runaway. If this occurs, turn off the temperature control for a while to let the 
device cool down. Consider improving the heat dissipation away from the device. 

 To protect against thermal runaway, set a maximum sink temperature in the 
Temperature Control window. For additional protection against overheating there is 
also a hard-coded limit of 70°C, above which the temperature control circuit shuts 
down.  
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Special Notes for Extended InGaAs Sensors 

To ensure accurate measurements with these sensors, adhere to the following points: 

 Before taking any spectra, ensure that the target temperature is reached. Verify the 
target temperature in the status bar at the bottom of the main window. 

 To take spectra for more than a few minutes, provide adequate cooling to the Qred 
housing. See UART Interface on page 9 for details. Monitor the case temperature in 
the Temperature Control window. 

 The software automatically compensates the dark signal as much as possible. 
However, due to the large magnitude of the dark signal, it may not be completely 
corrected. For precise measurements, set a fixed exposure time and take a 
background spectrum (see Absorption, Reflection, and Transmission Measurements 
on page 27 for details). 

 When using an Extended InGaAs sensor with 512 pixels, a comb-like zig-zag pattern 
may display in the spectrum. This is because odd and even pixels are processed 
differently inside the sensor. This pattern depends on how light is coupled into the 
spectrometer. If using an optical fiber, this pattern is usually invisible or very low. 
Recalibrate the spectral sensitivity with a calibrated tungsten lamp to further reduce 
this zig-zag pattern (see Calibration on page 29). 

Power Supply 

The Qred can be powered by USB only. However, in this case the power available for 
cooling the sensor is limited and may only be able to cooled to 5K to 10K below the ambient 
temperature. To cool the sensor below 0°C for precise measurements, an additional 
external power supply may be required. 

For initial measurements, connect the supplied AC power adapter to the device. This 
ensures that the sensor cooling is not limited by the power supply. Later, examine other 
power supply options if needed. 

When connecting the Qred to a regular USB port that can supply 500 mA, only 280 mA is 
available for cooling. If connected to a USB 3.0 port, this current may increase. Connect 
an external 12V power supply to the front-side AUX connector to achieve a maximum 
cooling current of 1.8A. 
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Sensor Gain 

The InGaAs image sensor used inside the Qred has two operation modes: 

 Low Gain mode provides a large dynamic range and better linearity. 

 High Gain mode is better suited for weak signals. 

Change the gain setting in the Device Configuration windows. When changing the gain 
setting, take a new set of dark spectra (see Calibration on page 29). 

For Qreds with an extended InGaAs sensor (beyond 1700 nm), High Gain mode is not 
recommended because the dark signal gets even larger and the nonlinearity cannot be 
reasonably corrected. 

Optical Setup 

The light enters the Qred spectrometer through a 20 µm slit (other slits are also available). 
This slit is observable by looking into the fiber optical connector on the front side of the 
device. 

If the measured light is quite strong, simply point the spectrometer towards it. For example, 
test the spectrometer by pointing it towards your computer screen or desk light. In most 
cases, however, a special optical probe is required to collect as much light as possible. To 
guide the light from the probe to the spectrometer, most users prefer a simple fiber optical 
cable with SMA connectors. Alternatively, light can be focused directly onto the entrance 
slit without fibers using your own optics. Use standard fiber optical cables with a core 
diameter of 400 µm. 

The calibration for the spectral sensitivity correction and the optical power was made with a 
400 µm fiber optical cable. If a different fiber is used, or especially if the spectrometer is 
pointed towards the light source, the measured spectrum might not be accurate. When 
using a calibrated light source, the spectral sensitivity can be recalibrated for any optical 
setup (see Calibration on page 29). 

Focus the light directly onto the entrance slit for the best sensitivity and lowest stray light. 
Ensure the following: 

 The focused light is aligned on the center of the entrance slit. 

 The height of the light spot on the entrance slit is 400 µm or smaller. 

 The numerical aperture of the focusing optics is close to 0.14, matching the numerical 
aperture of the spectrometer. 

The spectrometer does not detect light from outside a cone that corresponds to the specified 
numerical aperture. Therefore, if the focusing optics has a larger aperture, some light 
intensity is lost inside the spectrometer. 
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Troubleshooting 

Green and Red LEDs Are Continuously Lit 

This usually indicates that the device driver is not installed. 

Green Light on the Spectrometer Is Off, Red Light Is 
Flashing or Continuously Lit, and the Device Does 
Not React 

This indicates that the device has turned itself off because the USB port was not able to 
supply enough power. This also may happen if the USB cable is too long or damaged. 
Disconnect the device and try a different USB port or cable. 

Waves Cannot Find the Device 

Disconnect and reconnect the spectrometer, close the Device Config window, wait a few 
seconds, and open this window again from the File menu. If this does not resolve the 
issue, restart the PC and try again. 

Check the website for software updates. 

If the software still cannot find the device, check the Device Manager from the Windows 
Control Panel. The spectrometer should display as Qred in the Measurement and Control 
category. If the spectrometer is marked with an exclamation or question mark, remove the 
device, uninstall the software from the Windows Control Panel, restart the PC, and install 
the software again. 

If the spectrometer is not listed at all in the Device Manager, try a different USB port. If the 
device does not work on one PC, but works on others, the USB port may not provide 
enough power for the spectrometer. In this case, use an externally powered USB hub. 

For further assistance, contact Technical Support (see Getting Help on page 35). 
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Chapter 3:  Operation 

Introduction 

The Waves spectroscopy software is designed to provide a clean and straightforward user 
interface that does not impede or compromise advanced features and precision. For users 
new to spectroscopy, it is easy to start using the software and taking spectra without 
having to worry about details like calibration or dark spectra. For users with previous 
spectroscopy software experience, the following differences are noticeable in Waves: 

 One mode of operation includes all relevant types of measurements (absorption, 
irradiance, scope, and so on) through a consistent and clear interface. 

 Waves favors a simple self-explanatory terminology instead of complicated terms. For 
example, the software uses the term Exposure time instead of Integration time, 
because the average user does not know what is being integrated. 

 There are no wizards to help with complicated tasks, because wizards tend to conceal 
the actual task. These tasks are accessible through a clear and unified interface, for 
better understanding. 

Overview 

Upon launch, the software searches for an attached Qred spectrometer. If one is found, the 
software automatically initializes it. The software then presents the main window. The 
main window consists of several panels: 

1. Exposure Toolbar: Starts and stops taking spectra and sets the acquisition 
parameters. 

2. Spectrum List: Shows all spectra that are currently in memory. 

3. Properties Panel: Consists of five tab pages and displays many parameters and 
values of the spectrum currently selected in the Spectrum List. 

4. Main Diagram Panel: Shows all spectra from the list that are marked with a check 
mark. 

5. Display Parameters Panel: Determines how the spectra are displayed. 

  



Waves Spectrometer Software User Guide Spectrometer User Manual 
 

Broadcom  AFBR-Spectro-UG100 

17 

Figure 1 Waves Main Interface Window 

 

To create more screen space for the main diagram, minimize the other panels by selecting 
the triangles next to the panel title. 

Taking Spectra 

To take a spectrum, choose an exposure time, or select auto-exposure, select one of the 
green buttons ([ ] for a single shot or [ ] to start a continuous measurement). Increase the 
exposure time to decrease the noise level. If the amount of light detected during the 
exposure is too large for the CCD detector inside the spectrometer, the spectrum appears 
saturated and a red OVERLOAD warning appears at the top of the diagram. In this case, 
decrease the exposure time. Further increase the sensitivity by averaging across multiple 
exposures with the Averaging setting. 

If a spectrum acquisition takes longer than one second, monitor the progress in the status 
bar at the bottom of the window. The acquisition may finish before the progress indication 
reaches the end position, because the spectrometer is triggering on the end of the 
exposure period (see Triggering and I/O Port on page 33 for details). Stop the data 
acquisition by clicking the red stop button [ ]. 
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For auto-exposure, the exposure time for each new spectrum is set automatically based 
on the intensity of the previous spectrum. It may take a few spectra before the auto-
exposure control has reached its optimum. In auto-exposure mode, set a maximum 
exposure time to prevent very long exposure times in cases when there is simply no 
signal. 

Spectra can be taken with or without spectral sensitivity correction (see Calibration on 
page 29 for details). If the lightmeter button [ ] is selected, the spectral sensitivity of the 
spectrometer is automatically corrected and the intensity axis is measured in a physical 
unit like nW/nm. 

NOTE When taking a spectrum with spectral sensitivity correction, the 
noise in the spectrum is not evenly distributed because some parts 
of the spectrum are more amplified than others. Conversely, if this 
button is not selected, the spectral sensitivity is not corrected and the 
intensity axis displays values as they are produced by the 
spectrometer hardware. In this case, an uneven distribution of the 
sensitivity may be observed across the spectrum. For precise 
measurements, turn on the spectral sensitivity correction. 

The dark spectrum for the spectrometer sensor is stored in the device and automatically 
used when taking spectra (see Calibration on page 29 for details). For cases with 
background radiation, compensate for it by taking a background spectrum (see 
Absorption, Reflection, and Transmission Measurements on page 27). In the Exposure 
Toolbar, select the triggering mode (see Triggering and I/O Port on page 33) and choose 
a reference spectrum for absorption, reflection, and transmission spectroscopy (see 
Absorption, Reflection, and Transmission Measurements on page 27). 

Spectrum Display 

The Main Diagram Panel displays all spectra that are marked by a checkmark in the 
Spectrum List. If no spectrum is checked in the list, the currently selected spectrum 
(marked by a gray bar) is displayed. Check and uncheck all spectra at once by clicking the 
corresponding buttons, [ ] or [ ], on top of the Spectrum List. 

The peaks in the spectra are automatically determined. This not only works reliably for 
clearly defined peaks, but also for those lying in the side of another peak or those that are 
just above the noise level. If necessary, fine-tune the parameters for finding the peaks by 
selecting Peak Finder Parameters from the Tools menu. Three settings are available: 

 Absolute threshold: Determines how much a peak must be above the noise level to 
be considered as a peak. 

 Relative threshold: Describes how large a peak must be (compared to the local 
minima before and after it) to be considered as a peak. 
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 Position threshold: Determines how much of the top part of the peak is considered 
when calculating the peak position. 

Peak positions and widths are only displayed for the currently selected spectrum. The 
peak positions, heights, and widths are also displayed in the Properties panel and can be 
exported by selecting Export Peaks from the File menu. 

Use the Display Parameters panel below the diagram to select how the spectra are 
displayed. These settings affect the diagram display but do not modify the actual data. 
Change the scaling of both axes, change the unit of the wavelength axis, turn the display of 
the grid, turn peak positions and peak heights on and off, and see the coordinates of the 
current position of the mouse pointer. 

When zooming into the wavelength axis, a scrollbar appears at the bottom of the diagram 
for easily moving the displayed part of the spectrum. Alternatively, it is possible to grab 
and move the axis with the mouse. It is also possible to drag the intensity axis to change 
the maximum value and quickly enlarge weaker parts of the spectrum. 

To determine the intensity value at the position of the mouse pointer relative to a 
reference value, move the mouse to that reference value, click with the right mouse 
button, and choose Set reference level. 

Select a single wavelength or a range of wavelengths by clicking or clicking and dragging 
within the diagram. This selection can be used to compare wavelength values, display 
statistical data for this selection (see Working with Spectra), or to zoom (by right-clicking). 

Working with Spectra 

In Waves, several spectra can be loaded simultaneously for easy comparison and 
analysis. The Spectrum list is displayed in the upper left side. Whenever a new spectrum 
is taken, it appears in this list as current spectrum and overwrites any previous current 
spectrum. To keep this spectrum and take another one, select the single push-pin button 
[ ]. This prevents the current spectrum from being overwritten. Any new spectra are then 
appended to the list. Give the current spectrum a new name to prevent it from being 
overwritten. Keep all new spectra by selecting the button with multiple push pins [ ] in the 
Exposure toolbar. 

When multiple spectra are in the Spectrum list, one spectrum is always selected (marked 
by a gray bar). All metadata and additional information for this spectrum display in the 
Properties panel on the lower left side. The Properties panel contains five tabs: 

 General: Displays spectrum metadata. Name corresponds to the name in the Spectrum 
List. User is automatically set to the current Windows user name, but can be changed. 
Sample, Light, and Comments can be freely edited by the user. Change the color of 
the spectrum by selecting the color box. Note that User, Sample, Light, and 
Comments are the same for all spectra in the list. The y-axis property shows the 
physical quantity and unit that is assigned to the y-axis of the selected spectrum. 
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When this unit is changed, Waves attempts to convert the data automatically. If this is 
not possible without further information, a warning is displayed. 

 Values: Displays statistical values both for the whole spectrum and within the 
selection (if a range of wavelengths is selected in the diagram). 

 Color: Displays the most important colorimetric values. Further details are shown in 
the Colorimetric Analysis windows (see Tools on page 25). For precise color 
measurements, see the section on calibration accuracy in Calibration on page 29. 

 Peaks: Displays peak positions, heights, and widths. This list can be saved to a file by 
selecting Export Peaks from the file menu. 

 Data: Displays a list of all data values of the spectrum. 

Some of the values in the Properties panel are saved when saving the spectrum to a file. 
The others are recalculated when the spectrum is reloaded. 

File Operations 

Save 

Save the selected spectrum or the whole Spectrum list using the save options in the File 
menu. The File menu also has options for opening spectrum files to load them back into 
Waves for further evaluation (many other spectroscopy applications do not support this). 

The default file format for spectra is a simple ASCII table with columns delimited by the 
TAB character and some header lines containing the metadata. This allows the spectrum 
files saved by Waves to be read by almost any numerical analysis software (such as 
Origin, Excel, or Matlab). The default file extension for these files is .spz. Double-click 
a .spz file in Windows Explorer to open the file in the Waves application. 

To save disk space, save the data in a compressed format by selecting Save data as 
compressed zip files from the Options windows. The saved spectrum file is then a zip 
archive (still with the .spz file extension). To retrieve the spectrum data from this file without 
using Waves, change the file extension to .zip and unpack the file like any other zip 
archive. 

In Waves, spectrum data files written by other applications can also be opened if they are 
saved as ASCII tables or .csv files. Waves tries to automatically determine the file structure 
and can open many different file formats. 

Print 

Print spectra by selecting Print from the file menu. Select the Landscape page orientation to 
print spectrum diagram across the whole page. Choose the Portrait page orientation to 
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print the diagram on the upper half of the page. The lower half of the page shows selected 
metadata and values. 

The printing options are designed for the most common tasks. For further specific 
requirements for printing, export the diagram and then use a graphical design software or 
word processor for printing. 

Export 

Export a diagram as either a bitmap image or a PDF vector graphic. Both options are 
available by choosing Export from the File menu. 

After choosing a file name, set the height and width of the image and the resolution, if 
applicable. Note that text size and line width are constant. Therefore, labels and line widths 
appear smaller when a larger export size is selected. 

Spectrum Calculations 

The Modify menu offers several ways to evaluate and modify spectra. 

Adjust Offset 

Adjust Offset adds a constant value to all data points of the selected spectrum. The 
software suggests an estimated value for compensating an offset, but any other value may 
be chosen. It is also possible to adjust the offset for all spectra in the list. 

Normalize 

Normalize multiplies all data points of the selected spectrum by a constant factor. The 
default factor is chosen for the maximum value to be scaled to 100. Again, it is possible to 
adjust the offset for all spectra in the list. 

Differentiate 

The Differentiate option differentiates the spectrum with respect to the wavelength. 
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Apply Smoothing 

Apply Smoothing substitutes each data point by the average of the surrounding data 
points. Choose the number of data points to include in the averaging and which algorithm 
to use, including Savitzky-Golay smoothing. Rectangular smoothing is also known as 
boxcar averaging. 

Alternatively, it is possible to turn on smoothing in the display parameters panel below the 
spectrum diagram. This setting applies only to the way the spectra are displayed and does 
not change the actual data. 

NOTE Smoothing makes the data less precise, not more precise. 
Smoothing is intended to make a spectrum easier to understand for 
readers and does not provide any additional features in the 
spectrum that were not already there. 

Correct Baseline 

If a spectrum has several sharp peaks on top of a broad background signal, the Correct 
Baseline feature subtracts the background signal. This is especially useful to eliminate the 
broad fluorescence background in Raman spectra. 

Duplicate 

The Duplicate feature creates a copy of the selected spectrum and may be useful for 
modifying a spectrum while keeping the original one. 

Arithmetic Operations 

Arithmetic Operations create a new spectrum by adding, subtracting, multiplying, or 
dividing two spectra. 

Add Average Over All/Visible Spectra 

The Add Average Over All/Visible Spectra option calculates the average spectrum of all 
spectra in the list (or just the visible ones). 
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Create New Wavelength Scale 

The Create New Wavelength Scale option creates a new wavelength scale based on a 
given start and end wavelength and step width and interpolates all spectra accordingly. 

Tools 

Strip Chart 

Use the Strip Chart tool to display a characteristic property of the spectrum as a function 
of another property for all spectra in the list. The most common task is to display the 
temporal evolution of a characteristic value. This window can be kept open while taking 
new spectra to observe changes as they happen. 

In the lower left side of the Strip Chart window, choose which values to assign to the x and 
y axis of the chart. All numerical values that are displayed in the Properties Panel are 
available. To view the temporal evolution of a value, choose this value for the y axis and 
either Number in List or Time for the x axis. 

If Value from name is selected as the x or y axis, the software parses the name of each 
spectrum into a number. For example, if a list of spectra are named T = 10.3°C, T = 
15.2°C, and so on, these temperature value are used for the corresponding axis. 

In the Strip Chart diagram, the currently selected spectrum is marked by a slightly larger 
point. Points corresponding to spectra that are currently not visible in the main window are 
drawn in a lighter red color. 

Loupe 

Loupe opens a window with a magnified display of the spectrum around the mouse 
pointer. It may be used to study small features in the spectrum as an alternative to 
zooming. 

Colorimetric Analysis 

The Colorimetric Analysis window shows more detailed colorimetric values than the small 
panel in the main window. All colorimetric values are calculated according to CIE 
standards. 
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NOTE There are several settings in the Options window that are used for 
calculating colorimetric values, like color spaces and reference 
functions. 

Add Reference Spectra 

Add Reference Spectra shows all reference spectra used for colorimetric analysis. It is 
also possible to add a black body spectrum of a certain temperature. 

Peak Width Diagram 

Peak Width Diagram opens a window displaying the widths of the detected peaks (full 
width at half maximum). 

Absorption, Reflection, and Transmission 
Measurements 

Principle 

In absorption, reflection, and transmission spectroscopy, light is directed from a broadband 
light source onto a sample. Then, a spectrum, I(λ), is taken of the light transmitted through or 
reflected from the sample. To get meaningful results independent of the light source a 
spectrum is also taken of the light source without the sample as a reference, I0(λ). 

The spectral transmittance T(λ) or reflectance is then simply the fraction of transmitted or 
reflected light: 

𝑇(λ) =  
𝐼(λ)

𝐼0(λ)
 

 

This formula returns values ranging between 0 and 1. The transmittance is usually written 
as a percentage. The spectral absorbance, A(λ), is defined as: 

𝐴(λ) = log
𝐼0(λ)

𝐼(λ)
 

NOTE The absorbance is sometimes defined as the base-10 logarithm and 
sometimes as the natural (base e) logarithm. In Waves, both options 
are available. 
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Measurement 

To measure absorption, reflection, or transmission, first take a reference spectrum of the 
light source. If the measurement setup is not in complete darkness, take a background 
spectrum before the measurement. 

To take a background spectrum, turn off the light source, set an appropriate exposure 
time, and click Take Background Spectrum [ ] on the Exposure toolbar. To minimize 
noise, temporal averaging is recommended. If a background spectrum has been taken, 
select Use Background Spectrum [ ]. If a spectrum is taken afterwards, the background 
spectrum is automatically subtracted from the measured spectrum, eliminating unwanted 
background signals. 

To take a reference spectrum for transmission or absorption spectroscopy, turn on the light 
source again, remove the sample, set an appropriate exposure time and temporal 
averaging, and click Take Reference Spectrum [  ]. After selecting Use Reference 
Spectrum, take spectra of the sample for measuring absorption or transmission. 

To take a reference spectrum for reflection spectroscopy, a white reference sample is 
required to calibrate the setup for 100% reflection. However, all real-world reference samples 
have a reflection of less than 100% and an uneven spectral distribution. Therefore, for 
accurate measurements a reference spectrum must be supplied for the reference sample. To 
take a reference spectrum, place the white reference sample where the measured sample 
will be later placed. Then, set an appropriate exposure time and temporal averaging and 
click Take Reference Spectrum [ ]. In the following dialog window, specify a data file that 
includes a calibrated spectrum of your reference sample. After selecting Use Reference 
Spectrum [ ] measure reflectivity spectra. 

The y-axis of the spectrum now shows the relative intensity of the measured spectrum 
compared to the reference spectrum. In the Options panel from the File menu, select 
different units for displaying the spectra. The y-axis unit can be changed later from the 
Properties panel. 

If the light source does not cover the full range of the spectrometer, the calculated 
spectrum may show large amounts of noise outside of the wavelength range of the light 
source. This is normal and reflects the fact that the measurement has a large uncertainty 
at these wavelengths. 

These measurements are quite sensitive to changes of the sample illumination. If in doubt, 
take another reference spectrum to ensure it is still valid. 

Calibration 

The calibration for the wavelengths, dark spectrum, nonlinearity, and spectral sensitivity are 
stored in the device and loaded automatically during device initialization. In contrast to 
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almost any other spectroscopy software, it is not required to take dark spectra and other 
calibration parameters— they are done automatically. 

If the device has been used for a long time or if a very precise measurement is required, 
recalibrate the spectrometer with Waves and a suitable light source. Recalibration may 
also be required if the device temperature is outside of the calibrated temperature range. 
The device temperature is continuously monitored by the spectrometer and a warning 
displays if the temperature changes considerably. 

After recalibrating the spectrometer, restore the factory calibration at any time from the 
Device Configuration panel in the File menu. 

Calibration Accuracy 

The wavelength calibration is very accurate and changes very little with time or 
temperature. Therefore, most users will not require wavelength recalibration. The 
nonlinearity also hardly changes with time or temperature. 

The dark spectrum calibration depends significantly on the temperature and the exposure 
time. These dependencies are automatically taken into account and compensated, and 
should not affect testing. However, if in doubt or if as little noise as possible is a test 
requirement, recalibrating the dark spectrum is easy because no calibration light source is 
required. 

The calibration for the spectral sensitivity depends mainly on the optical fiber, the 
measurement probe, and how the light is coupled into the spectrometer. During 
production of the spectrometer, the user’s optical setup is unknown. Therefore, the factory 
calibration for the spectral sensitivity and especially the absolute intensity should not to be 
considered a precise reference, but rather a first estimate. If precise intensity 
measurements are required, recalibrate the sensitivity of the whole system, including fiber 
and probe. 

In addition, note that after changing the exposure time it takes a few spectra before the CCD 
sensor inside the spectrometer reaches its new equilibrium. This means that after changing 
the exposure time, the intensities of the following 5 to 10 spectra may not be as accurate as 
later measurements. Therefore, do not use the auto-exposure feature for precise 
measurements—set a fixed exposure time instead. 

Wavelengths 

Mapping of the individual pixels of the spectrum to wavelengths is done using a third-order 
polynomial. The four coefficients for this function are measured during manufacturing and 
stored in the device. Usually, this wavelength calibration does not change. Therefore, in 
most cases wavelength recalibration is not needed. However, if the ambient temperature has 
changed substantially, if the device has been used for a very long time, or to verify the 
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wavelengths are still correct, recalibrate the wavelengths with a suitable light source with 
several sharp atomic emission lines. These wavelength calibration sources are usually low-
pressure gas discharge lamps filled with Krypton, Neon, Mercury, Argon, or Xenon gas. 

To recalibrate, take a spectrum of this light source first. Ensure that the relevant peaks are 
automatically detected. If not, adjust the Peak Finder Parameters in the Tools Menu. 
Then, choose Calibrate Wavelengths from the Calibration menu. In the Light source 
combo box, select the type of light source being used. If the light source is not in the list, 
supply custom calibration lines. In this case, refer to the CalibrationLines xxx.dat files in the 
installation folder on your hard drive and create a new similar file containing the spectrum 
lines of your light source. 

After selecting the light source, click Start. The software attempts to match the peaks in the 
measured spectrum to the given spectrum lines for the light source. If a match is found, the 
average deviation displays. If the match seems to be successful, it displays in green, 
otherwise in red. If the measured peaks have successfully been identified, save the four new 
wavelength calibration parameters to the device by clicking OK. 

Dark Spectrum 

Inside the spectrometer, the spectra are detected with a CCD or CMOS line image sensor. 
Like all image sensors, this sensor detects a small signal even if there is no light entering the 
spectrometer. This signal depends on the individual pixel, exposure time, and temperature. 
To obtain a precise measurement with a small noise level, this Dark Spectrum must be 
recorded while no light enters the spectrometer and then subtracted from the actual 
measurement. 

For the Qred spectrometer, this dark spectrum has already been taken. It is stored in the 
device as a series of dark spectra for different exposure times together with temperature 
coefficients. During measurement, a dark spectrum for the current exposure time and 
temperature is automatically calculated and subtracted from the measured spectrum. 

To recalibrate the dark spectra, close the spectrometer entrance, ensure that no light 
enters the device, and choose Calibrate Dark Spectrum from the Tools menu. Then, 
click Take. Check the new dark spectra by clicking Test. While the test is running, 
observe the spectra taken without (red) and with (green) dark spectrum correction in the 
lower diagram. In the upper diagram observe the noise level, also without (red) and with 
(green) dark spectrum correction for a series of exposure times. Observe that the noise 
level of the raw data (red) increases significantly with increasing exposure time. With dark 
spectrum correction (green) however, the noise level should remain approximately at the 
same level for exposure times less than 1 second and increase slower for exposure times 
larger than 1 second. If this is the case, close the window by clicking OK. The new dark 
spectrum calibration is saved into the device. Otherwise, recalibrate or click Cancel. 
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Spectral Sensitivity 

Like all spectrometers, the sensitivity of the Qred spectrometer is not uniform across the 
spectrum, but depends on the wavelength. This is called spectral sensitivity and can be 
corrected by dividing each value of the spectrum by the corresponding sensitivity. This 
sensitivity calibration is also stored in the device. However, it is not always used when taking 
spectra because if the sensitivity is corrected, the noise level is unevenly distributed across 
the spectrum. Instead, choose spectral sensitivity correction by selecting lightmeter in the 
Exposure toolbar. 

To recalibrate the spectral sensitivity, use a light source with a continuous spectrum (like a 
tungsten halogen lamp) and a spectrum file containing the actual spectrum for this lamp. 

To recalibrate, choose Calibrate Spectral Sensitivity from the Tools menu. Connect the 
light source to the spectrometer and click Take Spectrum. When the spectrum is taken, 
click Load reference data to load the calibrated reference spectrum (meaning, a spectrum 
file that shows what the light source really looks like). Based on the measured spectrum 
and this file, the software calculates the spectral sensitivity of the spectrometer and shows 
it as a dark green line. To save this new calibration to the device, click OK. Enter the 
physical unit of the y-axis of the corrected spectra along with a description. 

To calibrate the absolute scale of the intensity axis, take a spectrum and also determine the 
absolute optical power (in watts) of this spectrum. When measuring the actual optical 
power with an optical power meter, ensure that the power meter only detects wavelengths 
that are within the wavelength range of the spectrometer (for example by choosing a 
suitable light source). Then, choose Calibrate power from the Tools menu and enter the 
actual power. Click OK. The new power calibration is stored in the device and used for 
scaling the intensity axis. This axis then displays the spectral power density in the physical 
unit specified in the Calibrate Spectral Sensitivity window. 

In addition, it is possible to calibrate the power not just with respect to the spectrometer 
entrance, but also to any other point in the optical setup. For instance, it is possible to 
calibrate the power that enters the measurement probe or any other power in the test setup, 
as long as it is proportional to the power that enters the spectrometer. Note that the optical 
powers and power densities displayed by the software refer to this value. 

Nonlinearity 

In an ideal spectrometer, the measured spectrum is exactly proportional to the incoming 
light intensity. All real spectrometers, however, exhibit certain nonlinear deviations. As an 
example, this means that reducing the light intensity by one half may not return exactly half 
the measured spectrum. Fortunately, this nonlinearity can be described by a polynomial 
function and corrected within the software. 
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The nonlinearity of each Qred spectrometer is calibrated during production and 
automatically corrected. This calibration hardly changes with time or temperature and 
should not be a factor in testing. 

However, to check or recalibrate the nonlinearity calibration open the Calibrate Nonlinearity 
window. A stable broadband light source with a smooth spectrum is required, like a tungsten 
or LED lamp. Connect the lamp and click Take to recalibrate the nonlinearity or Test to 
check it. 

Triggering and I/O Port 

Trigger Options 

Spectra are generally taken after clicking one of the green buttons ([ ] or [ ]) in the 
Exposure toolbar. It is also possible to set the spectrometer to wait for an event before 
taking a spectrum. This is called Triggering. In the Exposure toolbar, select one of three 
trigger modes: 

 Continuous: Spectra are taken as soon as possible. 

 Interval: Spectra are taken in regular time intervals. Specify the time between two 
spectra and also a time period after which the measurement is stopped. The timer 
progress is shown in the status bar. Obviously, this trigger mode does not apply to 
single-shot measurements. 

 External: Spectra are taken after the input voltage on one of the external I/O channels 
has changed. Use this to synchronize the exposure to other devices or external 
events. 

In the Device Configuration window, additional trigger options are available. These trigger 
options apply to external as well as to internal (continuous and interval) trigger modes. 

 Trigger on end of exposure: This is the default mode. The spectrometer is 
continuously taking spectra and when the trigger event occurs, the current spectrum 
is read out. This causes a random trigger delay between zero and the exposure time. 

 Trigger on start of exposure: The spectrometer is continuously taking spectra and 
when the trigger event occurs, the next spectrum after the one currently being taken 
is read out. Choose this mode to ensure that no light is collected for the spectrum 
before the trigger event occurs or before the button is clicked. This mode requires 
more time to take a spectrum. It also causes a random trigger delay between zero 
and the exposure time. 

For external triggering, there are additional options described below. 
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I/O Channels 

The spectrometer includes four digital I/O pins on the front-side auxiliary connector, which 
can be configured as trigger input, shutter or flash lamp control, process control, or general 
purpose I/O pins. Configure the channels in the Device Configuration window. See 
Specifications on page 36 for the pin assignments of the external connector. 

To use a channel as an external trigger source, perform the following steps: 

1. Set this pin to Input. 

2. Set the trigger pin number. 

3. Select either Falling Edge (trigger occurs when the input voltage drops from 3.3V to 
0V) or Rising Edge (trigger occurs when the voltage rises from 0V to 3.3V). 
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Chapter 4:  Software Development Kit 

The CD-ROM includes a Software Development Kit (SDK) for the spectrometer that can 
be used to control it and take spectra from additional custom software. The SDK includes a 
Windows Dynamic Link Library (DLL) for the .NET framework, documentation, and sample 
code. 

Alternatively, it is possible to directly communicate with the spectrometer from custom 
software including embedded systems. See the communication protocol manuals in the 
SDK for additional details. 
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Chapter 5:  Technical Support 

Getting Help 

For any questions, comments, or requests concerning the spectrometer or the Waves 
software, go to www.broadcom.com and click Support from the menu bar. There details 
on how to contact our Technical Support Team via e-mail or telephone. 

Software Updates 

Software updates are usually released at least twice a year. Find the latest version on our 
website. 

 

 

  

https://www.broadcom.com/
https://www.broadcom.com/
http://www.broadcom.com/
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Chapter 6:  Specifications 

Qwave 

Table 1 Qwave Specifications 

Specification Value 

Optical 

Focal length 75 mm 

Numerical Aperture 0.10 

Entrance slit 20 µm 

Spectral resolution FWHM VIS: 0.5 nm 

UV: 0.2 nm 

NIR: 0.4 nm 

Stray light < 0.05% 

Optical interface SMA connector 

Electronic 

Dynamic range 2000:1 (full scale, texp = 1s) 

Detector 3648 pixel linear CCD detector (VIS, UV: coated for enhanced 
UV detection) 

A/D converter 16-bit 15 MHz 

Calibration Wavelength, sensitivity, and multiple dark spectra stored within 
device 

Digital Interface (Qwave 1) USB 2.0 with Mini-USB connector 

Digital Interface (Qwave 2) 
USB 2.0 with Type-C connector, UART (serial), I2C 

Extension port 4 General purpose I/O channels 

Configurable as trigger input 

Digital interface for accessories 

Power supply 5V DC via USB (no power adapter required) 

Power consumption Typical: 180 mA, Maximum: 500 mA (with accessory) 

PC operating system Windows 7, Vista, XP 

Mechanical 

Dimensions 89.5 mm × 68.0 mm × 19.5 mm 

Weight 155g 
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Specification Value 

Operating temperature –15°C to 60°C (non-condensing) 

Storage temperature –25°C to 70°C 

Figure 2 Qwave Technical Drawing 

All dimensions in mm. 
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Qmini 

Table 2 Qmini Specifications 

Specification Value 

Optical 

Focal length 50 mm 

Numerical Aperture 0.1 

Grating 300 or 600 lines/mm 

Entrance slit 20 µm (can be changed by user) 

Spectral resolution FWHM ≥ 0.3 nm 

Stray light < 0.1% 

Optical interface SMA connector 

Electronic 

Dynamic range 500:1 (full scale, texp = 1s) 

Detector 2500 pixel linear CCD detector 

A/D converter 16-bit 

Calibration Wavelength, sensitivity and dark spectrum stored within 
device 

Digital Interfaces 
USB 2.0 with Type-C connector, UART (serial), SPI, I2C 

Extension port 4 General purpose I/O channels 

Configurable as trigger input 

Digital interface for accessories 

Power supply 5V DC via USB (no power adapter required) 

Power consumption Up to 130 mA 

PC operating system Windows 10, 8, 7, Vista, XP 

Mechanical 

Dimensions 64.0 mm × 42.0 mm × 14.5 mm 

Weight 60g 

Operating temperature –15°C to 60°C (non-condensing) 

Storage temperature –25°C to 70°C 
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Figure 3 Qmini Technical Drawing 

 

All dimensions in mm. 3D CAD files are available for download. 
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Qred 

Table 3 Qred Specifications 

Specification Value 

Optical 

Focal length 50 mm 

Numerical Aperture 0.14 

Grating 220 lines/mm 

Entrance slit 20 µm (can be changed) 

Spectral resolution FWHM ≥4.0 nm (depending on configuration) 

Stray light <0.1% 

Optical interface SMA connector 

Electronic 

Dynamic range 15000:1 

Detector Cooled 256 or 512-pixel InGaAs line sensor 

A/D converter 16-bit 

Calibration Wavelength, sensitivity, dark spectrum, and 
nonlinearity stored within device 

Digital Interfaces USB 2.0 with Type-C connector, others on request 

Extension port 4 General purpose I/O channels 

Configurable as trigger input 

Digital interface for accessories 

Power supply 5V DC via USB or 5V to 12V via Aux Connector 

Power consumption 200 mA (without cooling), up to 3A (with cooling) 

PC operating system Windows 10, 8, 7, Vista, XP 

Mechanical 

Dimensions 64.0 mm × 58.0 mm × 22.5 mm 

Weight 160g 

Operating temperature –15°C to 60°C (non-condensing) 

Storage temperature –25°C to 70°C 
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Figure 4 Qred Technical Drawing 

All dimensions in mm. 3D CAD files are available on request. 
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Pin Assignment 

9-Pin Auxiliary Interface 

Pins 4, 5, and 6 are only present on the square connector on the device and only intended 
for communication with optional accessories. Do not use these pins. 

All other pins are also present on the optional I/O port adapter. Use these pins for trigger 
input and general-purpose I/O. Use the power supply on pin 1 to supply small custom 
electronics. 

Figure 5 9-Pin Auxiliary Interface 

 

 

1 4 7 

2 5 8 

3 6 9 

 

1 2 3 7 8 9 

 

Qwave Extension Port 
(Connector viewed towards 

front side of device) 

I/O Port Adapter 
(Screw terminal block viewed 
towards front side of device) 
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Qwave 1 Pins 

1. +5V Power Supply (max. 300 mA) 

2. I/O Pin 0 

3. I/O Pin 1 

4. Extension Present (for accessories) 

5. Digital Interface SCL (for accessories) 

6. Digital Interface SDA (for accessories) 

7. I/O Pin 2 

8. I/O Pin 3 

9. Ground 

Qwave 2 Pins 

1. +5V alternative input power supply 

2. I/O Pin 0 

3. I/O Pin 1 

4. Reset (low active) 

5. Digital Interface I²C -SCL/UART RXD 

6. Digital Interface I²C -SDA/UART TXD 

7. I/O Pin 2 

8. I/O Pin 3 

9. Ground 
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30-Pin Auxiliary Interface 

This connector on the front side of the spectrometer is a Samtec TFM-115-02-L-D-WT. 
Either obtain the optional I/O port adapter for the Qred or design a custom accessory. 

ATTENTION The notch in the upper right corner of the connector does not 
indicate the position of pin 1. 

Figure 6 30-Pin Auxiliary Interface 

 

Compatible Samtec mating connectors include: 

 SMT right-angle: SFM-115-02-L-DH-TR 

 SMT straight: SFM-115-02-S-D-LC 

 SMT straight: SFMC-115-02-L-D (no alignment) 

 SMT straight: SFMC-115-L2-L-D (no alignment, Low Insertion Force) 

 SMT straight: SFM-115-L2-S-D-SN 

 Through-Hole: SFMC-115-[xx]-L-D- (SMT) 

 Wires: ISDF-15-D-M + CC03R-2830-01-G 

See below for a description of all interface pins. Contact us for additional information on 
the auxiliary interface. 

CAUTION All logic levels are 0V/3.3V (except power supply and USB). Do 
not connect any interface pin directly to the 12V power supply. 
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Table 4 Interface Pin Descriptions 

Pin 
Number 

Signal Name Alternative 
Function 

Type Description 

1 +12V_AUX_IN — PWR Power input 

2 USB_DN — IO USB bidirectional D– line 

3 GND — PWR Ground 

4 USB_DP — IO USB bidirectional D+ line 

5 VBUS — I VBUS pin (power on USB cable) 

6 UART_RXD GPIO I Receiver input for UART 

7 UART_TXD GPIO O Transmitter output for UART 

8 UART_CTS GPIO I Clear to Send input for UART 

9 UART_RTS GPIO O Request to Send output for UART 

10 GND — PWR Ground 

11 SPI_MISO GPIO I Master In Slave Out for SPI 

12 SPI_CS GPIO O Slave Select for SPI 

13 SPI_SCK GPIO O Serial clock for SPI 

14 SPI_MOSI GPIO O Master Out Slave In for SPI 

15 GND — PWR Ground 

16 RESENTn — I Reset is low active (to reset device keep 
low for >1 ms) 

17 TRIG_IO_0 GPIO/PWM IO Low-latency trigger input/output 

18 TRIG_IO_1 GPIO/PWM IO Low-latency trigger input/output 
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Pin 
Number 

Signal Name Alternative 
Function 

Type Description 

19 TRIG_IO_2 GPIO/PWM IO Low-latency trigger input/output 

20 TRIG_IO_3 GPIO/PWM IO Low-latency trigger input/output 

21 GND — PWR Ground 

22 I2C_SCL GPIO IO 
I2C clock input/output 

23 I2C_SDA GPIO IO 
I2C data input/output 

24 CAN_TD GPIO O CAN transmitter output 

25 CAN_RD GPIO I CAN receiver input 

26 GND — PWR Ground 

27 DAC — O 10-bit digital-to-analog converter 

28 ADC — I 10-bit analog-to-digital converter 

29 GND — PWR Ground 

30 +5V_AUX_OUT — PWR Power output (300 mA max.) 
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Chapter 7:  Certifications and 
Compliance 

Figure 7 CE Declaration of Conformity 

 

 

CE Declaration of Conformity 

 

The manufacturer 

RGB Photonics GmbH 

Donaupark 13 

93309 Kelheim 

declares that the products 

Qwave    Version 1.0 

Qwave    Version 2.0 

Qmini Version 1.0 

Qred Version 1.0 

comply with the following normative documents 

EN61000-6-4: 2007 + A1:2011 
EN61000-6-2: 2005 

and therefore with the following EG requirements 

 

Electromagnetic compatibility (2014/30/EU) 

 

This declaration applies to all models of the above named product 

version, in case it will be used in the configuration of  the test assembly. 
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Figure 8 FCC Compliance 

 

 
FCC Compliance 

This declaration applies to the following products: 

Qwave   Version 1.0 

Qwave     Version 2.0 

Qmini Version 1.0 

Qred Version 1.0 

 

This device complies with part 15 of the FCC Rules. Operation is 

subject to the following two conditions: (1) This device may not cause 

harmful interference, and (2) this device must accept any interference 

received, including interference that may  cause undesired operation. 

 

This equipment has been tested and found to comply with the limits for 

a Class A digital device, pursuant to Part 15 of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful 

interference when the equipment is operated in a commercial 

environment. This equipment generates, uses and can radiate radio 

frequency energy and, if not installed and used in accordance with the 

instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is 

likely to cause harmful interference in which case the user will be 

required to correct the interference at his own expense. 
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Figure 9 RoHS Declaration of Conformity 

 

 

 

 
RoHS Declaration of Conformity 

 
The manufacturer 

RGB Photonics GmbH 

Donaupark 13 

93309 Kelheim 

declares that the products 

Qwave    Version 1.0 

Qwave    Version 2.0 

Qmini  Version 1.0 

Qred Version 1.0 

contains no toxic substances which are specified in the 

RoHS Directive 2011/65/EU. 

 

The conformity to RoHS Directive 2011/65/EU is confirmed. 

This declaration applies to all models of the above named product 

version. 
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Revision History 

AFBR-Spectro-UG100; October 12, 2018 

Initial release. 
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